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This Job Aid is available online: 
• In the Public Folders: 

All Public Folders > Statewide > CONNECTIONS > Build 18 
• On the CONNECTIONS Intranet site: 

DFA Intranet Site > OCFS Home page > CONNECTIONS >Desk and Job Aids 

The CONNECTIONS Case Management Step-by-Step Guide provides detailed information and 
step-by-step instructions for Build 18 system functionality. This Step-by-Step Guide is available 
on CD and is distributed at the CONNECTIONS Case Management for Child Welfare Workers 
and CONNECTIONS Case Management for CPS Workers trainings. 

The OCFS CONNECTIONS intranet site also contains information about trainings offered to 
support you in your work with CONNECTIONS. 

 

Any visible identifying data 
in this Job Aid is simulated. 
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Introduction 

This Job Aid provides supervisors with the necessary information they need to use 
CONNECTIONS system Build 18 functionality effectively as part of their supervisory 
responsibilities. This is intended for supervisors and provides an overview of worker roles in 
order for supervisors to understand what their workers are responsible for and what they must 
monitor based on their worker’s assigned role(s). 

Specifically, this Job Aid contains information about: 
• assigned roles; 
• the Unit Summary window; 
• Staff and Case To-Do’s; 
• Family Services Intake;  
• the Family Assessment and Service Plan review and approval process; 
• Progress Notes; and  
• generating reports. 

 

This Job Aid assumes you have attended the 
CONNECTIONS Case Management for Child 

Welfare Workers, CONNECTIONS Case 
Management for CPS Workers and/or the 

Introduction to Build 18 trainings. 
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Assigned Roles 
A worker’s access to a stage in CONNECTIONS is the result of a combination of factors: the 
worker’s role in the stage, the worker’s role in the unit, and access permissions given to the 
worker.  

 
For ACS: 

The Child Planner role is 
identified as Case Worker in 

CONNECTIONS. 

In CONNECTIONS, there can be only one open FSS for a 
family per jurisdiction (Local District). Multiple workers, including 
one or more workers from Local Districts or Voluntary Agencies, 
may be assigned to this stage. Workers can be assigned the 
following roles in CONNECTIONS: Case Manager, Case 
Planner, Caseworker and/or CPS Worker/Monitor. These roles 
determine what workers can access and record (i.e., View vs. 
Maintain) in various system components.  

Case Manager Every FSS has a Case Manager, who must be a Local District 
worker. An FSS can have only one Case Manager at any given time. 
The Case Manager provides oversight of the case and approves the 
Family Assessment and Service Plan (FASP). If no Case Planner is 
assigned, the Case Manager acts as the Case Planner; in this 
circumstance, the Case Manager’s supervisor must approve the 
FASP. 

Case Planner The FSS may have a Case Planner, who may be either a Local 
District or Voluntary Agency staff person. An FSS can have only one 
Case Planner at any given time. The Case Planner is responsible for 
coordinating work with the family, as well as completing and 
submitting the FASP in a timely fashion; this includes reviewing the 
work of all other workers who have contributed to the FASP and 
accepting or revising that information accordingly. 

When the Case Planner submits the FASP, it is automatically sent to 
his/her system designated Unit Approver and to the Case Manager 
for approval. The Case Planner can alert the CPS Worker/Monitor in 
circumstances where that individual needs to complete or review the 
FASP. 

Caseworker One or more Caseworkers (who can be either Local District or 
Voluntary Agency staff) may be assigned to an FSS. Caseworkers 
who are assigned to an FSS complete work within the FASP, such as 
the Family Scales. A Caseworker may be responsible for a specific 
child, multiple children or no children in the FSS. A Caseworker can 
also be Associated to a specific child or children. If a Caseworker is 
responsible for a child, s/he should be Associated to that specific 
child; otherwise s/he cannot complete the Child Scales and Foster 
Care Issues component for that child. Associating a Caseworker to a 
specific child does not prevent other workers from working with that 
child or completing other parts of the FASP that may relate to that 
child in the overall Service Plan.  
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CPS Worker/ 
Monitor 

The CPS Worker/Monitor is responsible for overseeing case activities 
when: 

• the case was opened from an Indicated CPS Investigation 
stage; and 

• the CPS worker is not the primary service provider for the 
case; and  

• ongoing protective concerns have been identified. 

These activities include reviewing safety-related and risk-reduction 
actions and activities, determining that appropriate services are being 
provided, and modifying the service plan when the child’s or family’s 
progress is not sufficient to meet the desired outcomes identified in 
the plan. The CPS Worker/Monitor can also complete the Safety 
Assessment and Risk Assessment Profile in the FASP. 

For ACS: 
The CPS Worker/Monitor role will not be 
assigned by ACS. The Case Manager will 
assume the responsibilities of the CPS 
Worker/Monitor, which continues to be 
required by regulation. This applies when: 

• the case was opened from an 
Indicated CPS Investigation;  
AND 

• the CPS worker is not identified as 
the system Case Manager 
(incorporating the Case Planner role) 
or the system Caseworker; 
AND 

• ongoing safety and/or risk concerns 
have been identified. 

When the CONNECTIONS system role of 
CPS Worker/Monitor is not assigned, the 
Case Planner must complete the Safety 
Assessment and Risk Assessment Profile, 
since only the system Case Planner or CPS 
Worker/Monitor can do so. 

  

 

 

Page 4 CONNECTIONS – System Build 18 Supervisory Functions Job Aid v1.2– 10/4/2005 



 

As a supervisor, you need to be aware of what your workers are responsible for in the FASP 
based on their assigned role. This will help make sure that the appropriate worker is recording 
what s/he is responsible for; this supports data integrity and the validity of information. The table 
below outlines what workers are responsible for in the FASP based on their assigned role: 

Role View 
FASP 

Record 
FASP 

Assemble 
or Submit 

FASP 

Approve 
FASP 

Case Manager     

Case Planner        

Caseworker     

CPS Worker/Monitor     

Submission of the FASP to the Case Planner’s supervisor/Unit 
Approver remains a regulatory requirement; the FASP is 
automatically submitted to the supervisor that is designated as 
the Case Planner’s Unit Approver. This process is automated in 
CONNECTIONS for submission to both the Unit Approver and 
the Case Manager. Unit Approvers can add an additional 
approver. Workers who want or need to have their supervisor 
review their work in the FASP (before the Case Planner 
launches the Case Planner Summary) can send their 
supervisor a Reminder To-Do to review the FASP online.  

 
The Unit Approver (usually the 
unit supervisor) reviews and 
approves (or rejects) all work 
completed and submitted by 

workers in the unit. 

Each unit has one and only one 
approver. 

 
CONNECTIONS will not prevent 

the Case Planner from 
submitting the FASP for 

approval if you (the supervisor) 
are in the process of reviewing a 

worker’s documentation. 
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The following table explains the FASP approval process based on your worker’s assigned role. 
Your use of these methods depends on the assigned role of the workers you supervise.  

If you supervise a… Your Supervisory Responsibilities include… 

Case Manager  
(when a Case 
Planner is assigned) 

You are not required to approve the FASP; however, 
the Case Manager can add you as an approver. 

Case Manager  
(when no Case 
Planner is assigned) 

You must approve the FASP. 

Case Planner You must approve the FASP before the Case Manager 
is able to do so.  

CPS Worker/Monitor 
or 
Caseworker 

You should review any information contained in the 
FASP components the worker completed. The worker 
can send you a Reminder To-Do to alert you when to 
review the FASP components s/he completed, before 
the Case Planner launches the Case Planner 
Summary. Once the Case Planner launches the Case 
Planner Summary, other workers assigned to the 
stage may no longer add or modify “Draft” or “Final” 
entries in the components with the Case Planner 
Summary.  

 
The system will not prevent 

the Case Planner from 
submitting the FASP for 

approval if you (the 
supervisor) are in the process 

of reviewing a worker’s 
documentation.  

Supervisory Monitoring Tools 
Build 18 introduces the capacity for an online workload and electronic access to cases by 
multiple staff. In CONNECTIONS, ongoing child welfare services will be documented within a 
single, online real-time case record. As a supervisor, CONNECTIONS provides tools to assist 
you in managing your unit(s). In addition to supervising workers, you are responsible for 
monitoring the work of staff within your respective unit(s), 
including administrative, managerial and supportive tasks. 

Your ability to view documentation in CONNECTIONS 
depends on the level of security and your Business Function 
Profile assigned by your agency’s Security Coordinator. 
Having a role in the unit hierarchy as (or above that of) the 
Unit Approver, combined with certain Business Functions 
(e.g., UNIT SUM ACCESS, PERSON SEARCH, CASE 
SEARCH) will grant that access.  

 
More information about 

CONNECTIONS security is 
included in the Security Step-by-

Step Guide available on the 
OCFS CONNECTIONS  

intranet site. 
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The Unit Summary Window 
Monitoring the work of staff supports compliance with Federal Performance Improvement Plan 
(PIP) Standards for good casework practice, State and Federal regulations and agency policy. 
The Unit Summary window is your pathway to managing the workers you supervise by 
monitoring their workloads and their To-Do’s, and by reviewing their case documentation. From 
this window, you can navigate to each worker’s Assigned Workload or Staff To-Do List.  

From the Unit Summary window, you can navigate directly to the worker’s Assigned Workload 
by selecting a worker from the list and clicking on the Workload… button. From the worker’s 
Assigned Workload, you can navigate to the assigned stages; select a stage and click on the 
Tasks… button to view the case details/documentation. For example, you would select an FSS 
stage to review Progress Notes, the FASP or the Third Party Reviewer comments on the 
Service Plan Review window.  

You can view each worker’s Staff To-Do List to view any overdue To-Do’s, by selecting a worker 
and clicking on the To Do… button. The Staff To-Do List can help you determine whether a 
worker’s tasks are timely or overdue; you can use this information during your regular case 
conferences with workers or at supervisory meetings. You can also generate the Family 
Services Open Caseload Inquiry Report to gather this information (see page 42.) 

 
From the Unit Summary window, you can also assign or reassign stages and/or specific tasks to 
be completed within a stage; this could be due to balancing the workloads of workers in your 
unit/agency, agency restructuring, a worker leaving the unit or agency, or assigning roles as 
necessitated by any case events (e.g., CPS Worker/Monitor needs to be assigned if CPS issues 
are identified). By selecting a worker and clicking on the Workload… button, you navigate to 
that worker’s Assigned Workload. From the Assigned Workload, you can select a stage and 
click on the Assign… button, which opens the Assign window; from the Assign window you can 
assign work within the unit you supervise, or conduct a Staff Search to assign the stage to a 
worker in another unit. 
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For Family Services Stages, there are specific system rules 
that dictate who may assign roles, and what role(s) they may 
assign. Those rules are as follows: 

 • A Case Manager can assign any role. 
In CONNECTIONS, the Local 

District Case Manager or Case 
Planner can assign the 

Caseworker role to a worker 
from another Local District. 

• A Case Planner can assign any role with the exception 
of Case Manager. 

• A Caseworker can assign another Caseworker only. A 
Caseworker cannot assign the role of Case Planner, 
Case Manager or CPS Worker/Monitor. 

 

Step-by-Step: 
Accessing a Worker’s Assigned Workload 

1 Click on the UNIT button on the CONNECTIONS Toolbar.  
The Unit Summary Window displays.  

2 Click on the Search button. 
A list of workers within your unit displays. 

3 Select a worker from the list. 
4 Click on the Workload… button at the bottom of the window. 

The selected worker’s Assigned Workload displays. 

 

Step-by-Step: 
Assigning a Role within Your Agency  

1 From a worker’s Assigned Workload, select the desired stage(s). 
2 Click on the Assign… button. 

The Family Services Assign window displays with available staff in your unit.  
3 Select a worker and assign a role by clicking on the corresponding button. 
4 Click on the Save button. 

The Assigned Workload displays. 

 

Step-by-Step: 
Assigning a Role Outside of Your Agency  

1 From a worker’s Assigned Workload, select the desired stage(s). 
2 Click on the Assign… button. 

The Family Services Assign window displays with available staff in your unit.  
3 Click on the Options menu and select the Staff Search Criteria command. 

The Staff Search Criteria window displays. The Agency field pre-fills with the 
assigning worker’s agency code; to search outside your agency, delete the agency 
code. If you do not know the agency code, search for the worker’s Person ID by 
conducting a Person Search. Record the Person ID in the Person ID field on the 
Staff Search Criteria window (skip to step 5).  

4 Enter the person’s First and Last name in the respective fields. 
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5 Click on the Search button. 
The Staff List displays search results. If the search was not successful, the following 
message displays: 
“No staff match the entered search criteria. Please change the criteria.” 

6 From the Staff List, select the appropriate worker. 
7 Click on the OK button. 

The Family Services Assign window displays; the worker you added is automatically 
selected in the Available Staff grid.  

8 With the worker selected, assign a role by clicking on the corresponding button. 
The worker is added to the Assignments grid showing that the worker will be 
assigned a role. This assignment takes effect when you click on the Save button. 

9 Click on the Save button. 
The Assigned Workload displays. 
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Using Staff and Case To-Do Lists 
CONNECTIONS sends workers/supervisors To-Do’s to notify them of actions which must be 
taken on an assigned case, and of events in a case, including when something has happened 
or is about to happen. You can also send To-Do’s to yourself and others using CONNECTIONS. 

These To-Do’s appear on the Staff To-Do List and the Case To-Do List. The Staff To-Do List 
contains all To-Do’s for a specific staff person. The Case To-Do List contains all To-Do’s 
associated with a particular case, regardless of assignment. 

To-Do Lists are useful workload management tools in CONNECTIONS. The lists provide you 
with information about a particular stage. You can also organize your To-Do’s, keep the lists 
current by deleting outdated To-Do’s, and reassign To-Do’s that should be handled by another 
worker. It is a good habit to access your Staff To-Do List on a daily basis to review any work 
which has been submitted for your approval or to see if your workers have received any new 
assignments. 

 

There are three types of To-Do’s: 

Alert Alert To-Do’s are created by CONNECTIONS to notify workers that 
something has happened or needs to happen. For example, you are sent 
an Alert To-Do when a worker receives a new assignment. Alert To-Do’s 
are identified by an “A” in the Type column of a To-Do List. You can delete 
Alert To-Do’s at any time. Because they are not directly task-related, you 
cannot navigate directly from Alert To-Do’s to task-related windows. 

Reminder Reminder To-Do’s are created by CONNECTIONS users. You might create 
this kind of To-Do to remind yourself of an upcoming appointment. You can 
also send Reminder To-Do’s to other CONNECTIONS users (e.g., workers 
send you a Reminder To-Do to have you 
review the FASP). Reminder To-Do’s are 
identified by an “R” in the Type column of a 
To-Do List. Reminder To-Do’s can be 
deleted at any time. Because they are not 
directly task-related, you cannot navigate 
directly from Reminder To-Do’s to task-
related windows.  

 
Refer to the Internal Review 

Process on page 19 for 
information regarding a 

Reminder To-Do. 
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Task Task To-Do’s can be either system- or user-generated to notify workers that 
there is a task they must complete. Task To-Do’s are identified by a “T” in 
the Type column of a To-Do List. Task To-Do’s cannot be deleted. The only 
way to remove a system-generated Task To-Do from your Staff To-Do List 
is to complete that task or reassign it to another worker to complete. User-
generated Task To-Do’s can only be removed by entering a Complete 
Date on the To-Do Detail window. 
 
Creating a user-generated Task To-Do can be helpful if you need another 
worker to complete a task for a case. For example, you assign a worker a 
Task To-Do to record a Progress Note entry; this To-Do is created via the 
Progress Notes window by clicking on the Options menu and selecting the 
To Do command. If anyone other than an assigned worker or supervisor, 
such as clerical staff, receives a user-generated Task To-Do to complete 
Progress Notes, s/he has access only to the Progress Notes Detail window 
and the Progress Notes tab; all other tabs on the Family Services Stage 
window are disabled. 
 
An example of a system-generated Task To-Do is to approve the Family 
Assessment and Service Plan. You can navigate to task-related windows 
from a Task To-Do by selecting it from the list and clicking on the 
Navigate… button. 

 

Step-by-Step: 
Viewing To-Do’s on the Staff To-Do List 

1 Click on the TO-DO button on the CONNECTIONS Toolbar. 
The Staff To-Do List displays. 

2 Click on a To-Do to select it from the list. 
3 Click on the Detail… button. 

The To-Do Detail window displays for the selected To-Do. 
4 To close the To-Do Detail window, click on the Cancel button. 

The Staff To-Do List displays. 
5 To close the Staff To-Do List, click on the Close button. 
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The Family Services Intake (FSI) 
Information must be recorded in CONNECTIONS before a Family Services Stage (FSS) can be 
opened. Local District and Voluntary workers who have the proper security rights can record 
Family Service Intakes. Once a worker records all the required information, the FSI may be 
stage-progressed by the Local District and a Family Services Stage (FSS) may be opened; or, 
alternatively, the FSI stage may be closed if services are not to be provided. 

CONNECTIONS does not require Local District workers to submit an FSI to their supervisor for 
approval and stage progression; however, local policy may require a review. The Submit for 
Review function supports this process. Voluntary Agency workers also may submit an FSI to 
their supervisor using this process prior to submitting the FSI to the Local District for approval. 

The Submit for Review button at the bottom of the 
Decision Summary tab (or the Submit for Review 
command from the File menu) on the Family Services Intake 
window opens the Family Services Assign window. Workers 
must record all required information before an FSI can be 
submitted for review. If the FSI was created by a Voluntary 
Agency, it can be reviewed by a supervisor in the worker’s 
hierarchy before it is sent to a Local District for acceptance. 
Once submitted, the Local District can review the FSI (in 
view-only mode) and decide to accept or reject it. 

 
The Family Services Intake 

window is accessed by selecting 
an FSI stage on the worker’s 

Assigned Workload and clicking 
the Tasks... button. 

The FSI is placed on the Assigned Workload of the person creating the Intake (the only 
CONNECTIONS role available in the Family Services Intake is Caseworker and only one worker 
can be assigned that role at a time). From the Family Services Assign window, a worker selects 
the person to review the FSI. This removes the FSI from the submitting worker’s Assigned 
Workload and places it on the Assigned Workload of the worker selected as Caseworker on the 
Family Services Assign window.  

If the FSI is stage-progressed to a Family Services Stage (FSS), the worker who stage-
progressed it is automatically assigned the Case Manager role in the FSS. (For example, if you 
navigate via the Unit Summary window to stage-progress an FSI assigned to a worker you 
supervise, the FSS displays on your Assigned Workload with a role of Case Manager.) This role 
can be reassigned to another Local District worker (see “Assigning a Role” on page 8 for steps 
on how to reassign the stage). 
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The Family Assessment and Service Plan 
The Family Assessment and Service Plan (FASP) provides a uniform and effective method for 
workers to document their assessment of family and child functioning, strengths and needs. 
Ongoing assessment of family and child functioning, strengths and needs is important in 
achieving the goals of safety, permanency and well-being for children. These assessments form 
the basis for determining what aspects of family functioning need to change in order to support 
the desired outcomes. These assessments also establish a foundation for the service plan. 
Therefore, the FASP serves three distinct roles: 

• A record of past and current family functioning, including the identification of individual 
and family strengths, behaviors or conditions that indicate the risk of future abuse or 
maltreatment and an overall assessment of the family’s service needs 

• A record of plans to assist the family in meeting the needs and goals of safety, 
permanency and well-being 

• A guide and tool for casework practice and assessment, including calculation of risk 
ratings 

As a supervisor, you will review FASPs on a periodic basis. The specific requirements for any 
one FASP are dependent upon multiple factors, including the type of FASP (i.e., Initial, 
Comprehensive, Reassessment or Plan Amendment), as well as the Permanency Planning 
Goals (PPG), Program Choices and age(s) of the child(ren) in the service case. Each FASP is 
customized with respect to these factors. The FASP is dynamic; the “look” of the FASP changes 
as these factors are updated, utilizing information recorded in different areas of 
CONNECTIONS.  

The FASP tree displays only the components that are applicable to that particular case. 
CONNECTIONS customizes the FASP to include specific nodes, depending on the Program 
Choice, the PPG and the age(s) of the tracked child(ren). Sub-nodes within a specific FASP 
provide access to the applicable component detail windows.  

You should check the Tracked Children Detail window to make sure workers are selecting the 
correct PPG and Program Choice(s) in order to have the appropriate FASP components 
available for completion. This should be verified before workers begin completing any FASP. If a 
Program Choice or PPG is incorrect, CONNECTIONS might require completion of components 
that are not relevant or omit presenting sections essential to a complete assessment. PPG and 
Program Choice selections can be modified once the FASP has been started (launched); this 
can result in components being added to or removed from the FASP tree. CONNECTIONS will 
not remove components from the FASP tree once a worker has recorded information in the 
specific component; the component must be complete in order to submit the FASP. 

At times, you may want your workers to record information on components that are not 
presented on the FASP tree based on the rules in effect. Clicking on the Add Component 
option from the Family Assessment and Service Plan window and selecting which component(s) 
to add, adds the selected component(s) as long as there are no pending approvals. If an 
approval is pending, components can only be added by the Case Planner.   

The timeframes for when a FASP must be completed remain the same as the paper-based 
Uniform Case Record (UCR). Unlike the UCR, workers can only initiate (Launch) a FASP within 
designated time frames, as illustrated in the graphic on the next page.  

CONNECTIONS – System Build 18 Supervisory Functions Job Aid v1.2 – 10/4/2005 Page 13 



 

Page 14 CONNECTIONS – System Build 18 Supervisory Functions Job Aid v1.2– 10/4/2005 



 

The Plan Amendment 

 
For ACS: 

All planned status changes must 
be documented and pre-

approved by the ACS Case 
Manager through the use of 
Progress Notes. If the Plan 

Amendment can be launched, it 
is to be completed and 

submitted within 15 days of the 
status change. 

An exception to this is a child’s 
first movement within foster 
care, which does not require 
pre-approval by ACS if the 

move is made within 120 days 
of initial placement and the 
move is to the same level of 

care within the same agency. 

 

A Plan Amendment is a type of FASP that is used to record any 
significant changes that occur between FASP cycles. As a type 
of FASP, Plan Amendments are also completed online and the 
rules for review and approval are the same as for all FASP 
types. Plan Amendments are launched from the FASP window 
and can only be launched between FASP cycles for an 
approved FASP. One cannot be launched if there is an In-
Process FASP or a Pending FASP. In these cases, the 
changes that need to be made must be recorded in the 
appropriate FASP rather than in a Plan Amendment, unless the 
Plan Amendment is for the purpose of closing the Family 
Services Stage.  

A Plan Amendment may be completed for any approved FASP 
type (i.e., Initial, Comprehensive or Reassessment) and is 
supported for both FSS/CWS and FSS/CCR stages. In order to 
have access to the necessary status change options, the child’s 
Program Choice must be changed on the Tracked Children 
Detail window prior to launching and completing the Plan 
Amendment. If the Program Choice is not modified prior to 
launching the Plan Amendment, workers can update the 
Program Choice after they launch the Plan Amendment which 
adds the status change(s) to the Plan Amendment Maintenance 
window.  

The selection of Plan Amendment nodes is similar to how 
workers start completing a Plan Amendment on the paper-
based version; they select the reason(s) for completing a Plan 
Amendment. When a Case Planner or Caseworker launches a 
Plan Amendment, s/he selects the desired status change(s) in 
the Plan Amendment Maintenance window by clicking on each 
desired sub-node and adding it to the selected Status Changes 
grid. Upon clicking on the Save button on the Plan Amendment 
Maintenance window, CONNECTIONS dynamically builds the 
appropriate sub-nodes on the FASP tree.  
(See the graphics on the following pages.) 

For ACS: 

When a status change occurs at 
a time when a Plan Amendment 

cannot be launched:  

 the status change(s) must be 
documented in Progress Notes 

and in the next FASP; 

 WMS and/or CCRS must be 
updated immediately; and The Case Planner submits the Plan Amendment for approval 

using the same method used for other types of FASPs (from the 
Check FASP Detail Component Status window). When a Plan 
Amendment is submitted, all workers in the stage receive an 
Alert To-Do on their Staff To-Do List. 

 the Case Planner must send a 
Reminder To-Do to the Case 

Manager alerting him/her of the 
status change and requesting 
approval. Both the request and 

the Case Manager’s action 
(approval or rejection) must be 
documented in Progress Notes. 
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Step-by-Step: 
Creating a Plan Amendment and Selecting a Status Change 

1 On the FASP window, click on the drop-down arrow 
for the Launch New FASP… field and select Plan 
Amendment from the resulting list.  

 2 Click on the Launch button. 
The preliminary launch edits begin. Multiple status changes can be 

selected at once by holding 
down the Shift key while 

clicking on the desired rows (to 
select adjacent rows) or by 

using the Ctrl key while clicking 
with the mouse 

(to select adjacent or 
non-adjacent rows).  

3 Once the edits have been completed, Plan 
Amendment is added as a node on the FASP Tree. 
Several secondary edits must be passed to launch a 
Plan Amendment successfully. 

4 Click on the Plan Amendment node. 
The Plan Amendment Maintenance window displays. 
“Update Service Plan” displays on the Selected 
Status Changes list.  

 

5 Highlight the desired status change(s) on the Status 
Change list. 

6 Click on the >> (Add) button. 
The selected status changes are added to the 
Selected Status Changes list.  
If necessary, repeat Steps 5 and 6 to add more status 
changes. 

Program Choice directly impacts 
the status change options 

available to you on the Plan 
Amendment Maintenance 

window.  7 Click on the Save button when you have added the 
desired status changes. For example, to select the 

status change of “Preventive 
Services Ended,” you must do 

so after launching the Plan 
Amendment, but before end 

dating the corresponding 
Program Choice on the Tracked 

Children Detail window.  

In another example, if you are 
using a Plan Amendment to 
record that a child receiving 

Preventive Services was placed 
in foster care, you must launch 
the Plan Amendment, add the 

Program Choice of “Placement” 
on the Tracked Children Detail 
window, and only then will the 

status change of “Child 
Entering/Reentering Foster 
Care” display on the Plan 
Amendment Maintenance 

window.  
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Launching a Plan Amendment 
When a FASP is available for Launch 

 

 
Selecting Status Changes 

 

CONNECTIONS – System Build 18 Supervisory Functions Job Aid v1.2 – 10/4/2005 Page 17 



Selected Status Changes 

 
 

Plan Amendment Status Changes  
Added to the FASP Tree 
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The Family Assessment and Service Plan Review and Approval Process 
The FASP nodes (e.g., Strengths/Needs and Risks, Service Plan) are not approved separately, 
but together as part of the FASP approval process. You review case documentation recorded by 
the workers in your unit by evaluating each worker’s documentation for thoroughness and 
accuracy. You consider whether it meets established child welfare and agency standards for 
good casework practice (e.g., what a Caseworker needs to document to support a case) and 
either approve or reject the documented work. Building in a review process in your agency will 
provide you with the opportunity to make certain that workers are recording the appropriate 
information about the child or family in each FASP component. This will be crucial prior to the 
family reviewing the document and prior to the Service Plan Review.  

As a supervisor, there are two methods available for you to review a FASP: the Internal Review 
Process and the Formal System Review and Approval Process. The Internal Review Process is 
not prompted by CONNECTIONS itself; rather it depends on you and your staff to take certain 
steps. The Formal System Review and Approval Process is built into CONNECTIONS, forcing 
you to complete the process. 

Your use of these methods depends on the assigned role of the workers you supervise.  

If you supervise a: Review Process 
Case Worker Internal Review  
Case Planner Formal System Review and 

Approval 
Case Manager  
(with no Case 
Planner assigned) 

Formal System Review and 
Approval 

Case Manager 
(with a Case Planner 
assigned) 

Internal Review  

Internal Review Process 
Agency policy may require, or workers may desire, supervisors to 
review their documentation in the FASP (before the Case Planner 
launches the Case Planner Summary). Workers accomplish this 
by sending a Reminder To-Do to their supervisor to review the 
FASP online. Remember that as a worker’s supervisor, you can 
review his/her work at any time without receiving a Reminder To-
Do. You can access a worker’s assigned stages via either a Case 
or Stage Search or by accessing the stage on the worker’s 
Assigned Workload via the Unit Summary window.  
(See “The Unit Summary Window” on page 7 for details.) 

When generating a Reminder To-Do (see “Generating a 
Reminder To-Do” on page 20), your workers must conduct a Staff Search to designate you as 
the reviewer. The worker enters your name, conducts a Staff Search and then selects you from 
the search results. The worker must record a short description of what to review. Once the 
Reminder To-Do is saved, it is added to your Staff To-Do List.  

 
The system will not prevent 

the Case Planner from 
submitting the FASP for 
approval if you are in the 
process of reviewing a 

worker’s documentation. 
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You access your Staff To-Do List and view the details of the Reminder To-Do (see “Viewing a 
Reminder To-Do and Navigating to Work to be Reviewed” on page 21). You then access the 
worker’s Assigned Workload, select the FSS stage and navigate to the work to be reviewed. 
Once you access the FASP, you can review each node or sub-node individually. You can click 
on each sub-node individually to review the information contained on the window(s) or click on 
the Reports menu and select the desired node (or sub-node) to review. The selected node or 
sub-node displays in Print Preview format. 

If in your review, you determine that further work should be documented in any of the FASP 
nodes, you will communicate the specific nodes that need to be modified, either directly to the 
worker or via a Reminder To-Do that appears on the worker’s Staff To-Do List (see below for 
steps on creating a Reminder To-Do).  If you are the supervisor of a Case Planner and upon 
your review you are confident that the FASP is complete, you can advise the Case Planner to 
submit the FASP for formal approval. 

This same process applies for the internal review of any case documentation. A review process 
for anything other than the FASP is subject to the policies and procedures that every agency 
should develop and consistently apply. 

 

Step-by-Step: 
Generating a Reminder To-Do 

1 Click on the To-Do icon. 
2 Click on the New… button on the Staff To-Do List. 

The To-Do Detail window displays. The Short Desc field is empty, since you have 
not associated the To-Do with a particular stage or task. 

3 Click on the Staff button. 
4 Record the name (e.g., supervisor’s name).  
5 Click on the Search button. 
6 Select the worker/supervisor and click on the OK button. 
7 Record comments in the Short Desc field.  
8 Click on the Save button. 

The To-Do is saved and added to the designated Staff To-Do List. 
9 Click on the Close button. 

The CONNECTIONS Toolbar displays. 
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Step-by-Step: 
Viewing a Reminder To-Do and Navigating to Work to be Reviewed 

1 Click on the To-Do button. 
2 Select the Reminder To-Do designated with an “R” in the Type column. 
3 Click on the Detail button. 

The To-Do Detail window displays. 
4 Click on the Cancel button. 

The Staff To-Do List displays. 
5 Click on the Close button. 

The CONNECTIONS Toolbar displays. 
6 Click on the UNIT button on the CONNECTIONS Toolbar.  

The Unit Summary window displays.  
7 Click on the Search button. 

A list of workers within your unit displays. 
8 Select a worker from the list. 
9 Click on the Workload… button at the bottom of the window. 

The selected worker’s Assigned Workload displays. 
10 Select the desired FSS stage. 
11 Click on the Tasks… button. 

The Family Services Stage displays for you to review the work (e.g., the FASP). 
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Formal System Review and Approval 
There are several behind-the-scenes processes in CONNECTIONS when a FASP is submitted 
for approval. Because the FASP is comprised of multiple components, these processes review 
each FASP component for completeness. If a required tab or field was not completed, the FASP 
submission process suspends. The Case Planner is presented with a list of the incomplete 
components (e.g., Family Update, not what is missing in the component); this enables the Case 
Planner to return to each affected node and complete the necessary information. 

Once all of the FASP components are reviewed and found to be 
complete by the system, Approval Task To-Do’s are created 
when the Case Planner clicks on the Submit button on the 
Check FASP Detail Component Status window. The Case 
Planner saves this Approval Task To-Do and the FASP is 
automatically submitted to the person designated as the Case 
Planner’s Unit Approver and to the Case Manager for approval. 
A message displays, listing to whom the Approval Task To-Do’s 
have been submitted, with the option of adding an additional 
approver. If the Case Planner adds one or more additional 
approvers (this is allowed only within the Case Planner’s own 
agency), those additional approvers must approve the 
FASP before the Case Manager can do so.  

 
Any changes in roles and/or 

designating an 
approver/supervisor should be 

made in CONNECTIONS before 
launching and submitting the 

FASP. 

 
If the Case Planner is the supervisor/Unit Approver, the 
following message displays on the To Do Detail window: 
“Case Manager submitted this approval. Approval Todo created 

for Case Manager. You must submit this approval to another 
worker in your Agency.” 

When the FASP is submitted by 
the Case Manager (in cases 
where no Case Planner is 

assigned, so the Case Manager 
is acting as the Case Planner), 

CONNECTIONS sends an 
Approval Task To-Do to the 
Case Manager’s designated 

Unit Approver. 

• Clicking on the OK button displays the Staff Search 
Criteria window requiring the Case Planner to select 
another approver from his/her unit; this process must 
occur before the Case Manager can approve the 
FASP. 

The following message displays if the Case Planner attempts to 
close the Approval To-Do without selecting another approver: 

“You must submit this approval to another worker in your 
Agency.” 

As a supervisor, you can submit the FASP for approval on 
behalf of the Case Planner once the Case Planner has 
completed all required components. To submit the FASP, you will navigate to the Case 
Planner’s Assigned Workload via the Unit Summary window. CONNECTIONS records that you 
sent the FASP for approval on behalf of the Case Planner; this is reflected on the Approval 
Status window and in the Event List. There is the option to add another approver (e.g., another 
supervisor). If the Case Manager is acting in the role of the Case Planner (i.e., no Case Planner 
is assigned), you cannot submit the FASP for approval on behalf of that worker, since you would 
then be responsible for the final approval (because you are the Case Manager’s supervisor/Unit 
Approver). 

The Case Planner’s supervisor/Unit Approver and the Case Manager are notified of the 
submission by an Approval Task To-Do on the Staff To-Do List. The system simultaneously 

If the Case Manager is also the 
Unit Approver, the Assigned To 
field will be blank and the Case 

Manager must search for 
another staff member in his/her 
agency to whom s/he will submit 

this approval. 
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generates two Approval Task To-Do’s: one for the Case Planner’s designated Unit Approver 
and one for the Case Manager. You can navigate from your Staff To-Do List to approve the 
FASP.  

From the Staff To-Do List, you can select the Approval Task To-Do and view the details of the 
To-Do by clicking on the Detail… button. Clicking on the Navigate… button displays the FASP 
report, which was created upon submission.  

 

You navigate to this report (rather than to the individual FASP 
windows) via the Approval Task To-Do that you received. The 
format of the report will be different from the layout of the 
information on the windows, but it contains the same content 
(excluding the individual entries where the Case Planner 
Summary exists; only the Case Planner Summary is presented 
in the report format), including all case, stage and worker 
identifying information. Until the FASP is approved, the FASP 
report can only be accessed via the Approval Task To-Do. 
However, all assigned workers may still view the FASP 
information online in the window format until the FASP is 
approved. As a supervisor, you can access the FASP window 
via the Unit Summary window to compare what individual 
workers recorded versus what the Case Planner recorded in the 
Case Planner Summary. The Case Manager can navigate via 
his/her Assigned Workload to view individual worker entries 
versus the Case Planner Summary. 

 
If you supervise workers who 

share cases with the 
OCFS/Division of Rehabilitative 
(DRS), the order of the approval 

process adds a step for the 
DRS worker to approve the 

FASP: 
1. Case Planner to the Case 

Planner’s supervisor/Unit 
Approver (also to any additional 

approvers within the Case 
Planner’s agency) 

2. DRS approver (the 
OCFS/DRS Caseworker) 

3. Final approval by the Local 
District Case Manager 

Refer to the OCFS Custody 
Youth Placed in Voluntary 

Agencies Job Aid available on 
the OCFS CONNECTIONS 

Intranet site for details. 
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FASP Report  

 
Once you have reviewed the FASP, you must record an approval decision. Select the approval 
item in the grid and click on the Approve button. The following message displays, providing the 
option to add an additional approver:  

“Approval completion will freeze events. Do you wish to add another approver?”  

If you click on the No button, an additional approver is not added and you can complete the 
approval by clicking on the Save button. If you click on the Yes button, the Staff Search window 
displays, allowing you to search for and subsequently add another approver. Clicking on the 
Help button displays CONNECTIONS Online Help. 

As each approver records an approval of the FASP, that 
approval is marked as APRV (“Approved”). At this point in the 
formal process, your role in approving the FASP is complete 
and the Case Manager can now review the FASP. Any 
outstanding approvals (e.g., the Case Manager’s or any 
additional approvers) display with a PEND (“Pending”) status on 
the Approval Status window. This can serve as an indication to 
the Case Manager that s/he must approve the FASP.  

 

You can easily monitor the approval status by checking the 
Approval Status window, which can be accessed from the Event List. If the Case Manager 
navigates from an Approval Task To-Do that has pending approvals, s/he cannot approve the 
FASP, but is notified that a pending approval exists (e.g., Case Planner’s supervisor/Unit 
Approver must approve the FASP first). 

The status of the FASP 
approval can be checked from 
the Approval Status window or 

from the Event List for a 
selected stage. 
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Once the Case Manager (acting as the final approver) reviews and approves the FASP, the 
information previously recorded on the various FASP components can now only be found on the 
Final FASP report document. Careful consideration must be taken when that final approval is 
recorded; whatever information is recorded in the system for that stage will remain frozen as 
part of the case record and will be included on any system outputs. You can view previous 
FASPs from the FASP tree; the manner in which the information displays is dependent on 
whether the FASP is in-process, pending, or is approved. You can also view previous FASPs, 
from the Event List in view-only mode.  

 

Step-by-Step: 
Approving a FASP 

1 Click on the TO-DO button on the CONNECTIONS Toolbar.  
The Staff To-Do List displays. 

2 From the Staff To-Do List, select the Task To-Do with the following 
description: “<Worker initials>-Approve <Type> FASP for FS Stage <Name>.”  

3 Click on the Navigate… button. 
The FASP report displays. 
You can click on the Print button to print a copy of the FASP report. 

4 When you have finished reviewing the report, click on the Close button. 
The Approval Status window displays.  

5 Select the approval item listed with your name in the grid. 
6 Click on the Approve button.  

The following message displays: 
“Approval completion will freeze events. Do you wish to add another approver?” 

7 Click on the No button to complete the approval without adding another approver. 
Skip to Step 12. 
—OR— 
Click on the Yes button to add another approver. 
The To-Do Detail window displays. 
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8 Click on the Staff… button. 
The Staff Search Criteria window displays. 

9 On the Staff Search Criteria window, enter the approver’s name in the First and Last 
Name fields. 

10 Click on the Search button. 
The Staff List displays with the results of your search. 

11 Select the approver and click on the OK button. 
The Approval Status window displays, with the selected person listed in the 
Assigned To field. 

12 Click on the Save button. 
The Staff To-Do List displays. 
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Rejecting a FASP 
In the review process, you or the Case Manager may find that submitted work needs to be 
rejected if it is incomplete or inaccurate. To reject the FASP (and any other work in 
CONNECTIONS), you must record comments explaining what the Case Planner needs to 
modify; recording comments enables the Reject button. CONNECTIONS sends a Task To-Do 
that displays on the Case Planner’s Staff To-Do List with a status of REJT (“Rejected”). The 
Case Planner can then navigate to the task in order to modify and resubmit the FASP. The 
FASP cannot be approved by other approvers when it has been rejected. If an approver 
navigates from the Approval Task To-Do, a message displays, indicating that the approval has 
been invalidated by another approver and that the Approval Task To-Do will be deleted. When 
the approver clicks on the OK button in response to that message, the Approval Status window 
displays the REJT (“Rejected”) status for the approver who rejected the FASP, and INVD 
(“Invalidated”) for all other outstanding approvals. The only way to exit the Approval Status 
window in this circumstance is to click on the Cancel button; the Approval Task To-Do no longer 
displays on the Staff To-Do List. 
Events are generated to the Event List when you reject submitted work. You will be able to view 
the original reason(s) for rejecting the task to make certain the worker has made the requested 
modifications. 

 

Step-by-Step: 
Rejecting a FASP 

1 Click on the TO-DO button on the CONNECTIONS Toolbar.  
The Staff To-Do List displays.  

2 From the Staff To-Do List, select the Task To-Do with the following 
description: “<Worker initials>-Approve <Type> FASP for FS Stage <Name>.” 

3 Click on the Navigate… button. 
The FASP report displays. You can click on the Print button to print a copy of the 
FASP report. 

4 When you have finished reviewing the report, click on the Close button. 
The Approval Status window displays.  

5 Select the approval item listed with your name in the grid. 
6 Record comments in the Comments field. 

The Reject button enables.  
7 Click on the Reject button. 

The status of the To-Do changes to REJT (“Rejected”).  
8 Click on the Save button. 

The Staff To-Do List displays. 
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Stage Closure Process 
Only the Case Planner or the Case Manager may close a Family 
Services Stage (FSS). If the Case Planner or Case Manager is 
submitting an FSS/CWS or FSS/CCR for closure, 
CONNECTIONS determines whether a Plan Amendment with 
an “ending” or “discharge” type exists for this stage, or if there is 
a Family Assessment and Services Plan (FASP) for this stage 
currently in Pending status or approved within the last 30 days. 
If one of these criteria exists, the system proceeds with the 
stage closure. 

 
If the Case Planner initiates the 
stage closure, s/he submits it to 
his/her Unit Approver and Case 

Manager for approval. 

If the Case Manager initiates 
the stage closure, s/he submits 
it to his/her Unit Approver for 

approval.  

If the Case Planner or Case Manager is submitting an FSS/OTI, 
FSS/COI, FSS/ADVPO or FSS/ICPC stage for closure, the 
closure can be submitted without any further work or checks by 
the system. 

Closing a Family Services stage also closes the corresponding case if the FSS is the only open 
stage in the case, other than an ARI stage. The case is not closed if there is an open FSI, FSS, 
CPS Intake or CPS Investigation. 

To close an FSS, the Case Planner or Case Manager selects the desired stage from the Stage 
Information grid on the Case Summary window and clicks on the drop-down arrow for the 
Reason Stage Closed field. The desired closure reason is then selected from the resulting list. 
S/he then clicks on the Submit button to submit the stage closure to the appropriate person(s) 
for approval.  

Stage Closure Approval Process 

 

Once all of the submission criteria are met, an Approval Task 
To-Do is created. The Case Planner saves this Task To-Do and 
the FSS is submitted to the Case Manager and the Case 
Planner’s Unit Approver for review and approval. Two Approval 
Task To-Do’s are created: one for the Case Planner’s 
designated Unit Approver and one for the Case Manager. You 
can navigate from your Staff To-Do List to approve the stage 
closure by clicking on the Navigate… button.  

If someone other than the 
Case Manager or Unit 

Approver attempts to approve 
an FSS closure, the following 

message displays: 
“Case Manager/Supervisor 

Approval is needed.” If the FSS is the only stage in the case, when you click on the 
Navigate… button, the following message displays: 
“Closing of stage will close the case – do you wish to continue?” 

To proceed with the case and stage closure, click on the Yes 
button and the Case Summary window displays. The Case 
Summary window displays immediately upon clicking on the 
Navigate… button if the case has other open stages.  

If this FSS was one in which the Stage Closure Question was 
required and answered, the following message displays, along 
with the Case Summary window: 

The To-Do Detail window 
displays the appropriate 

person. 

If the FSS being submitted for 
closure involves a child who is 

in the custody of OCFS and 
has been placed in a Voluntary 

Agency, the Case Planner’s 
submission is first directed to 
the Division of Rehabilitative 

Services (DRS) worker 
assigned to the stage, then to 
the Case Manager of the FSS. 

“The Closure Question has been answered.” 
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You can then click on the OK button to close the message 
window and review the information recorded on the Case 
Summary window. After reviewing the closure information, 
cancel out of the Case Summary window and the Approval 
Status window displays. Here, you must select your name and 
click on the Approve button. The following message displays: 

 
If there is a Pending FASP, it 
must be approved before the 

stage closure can be approved. 
“Approval completion will freeze Events.  
Do you wish to add another approver?” The following message 

displays if a supervisor clicks 
on the Approve button when 

there is a Pending FASP: 
”Pending FASP must be 

approved first.” 

If no other approver is needed, click on the No button and then 
the Save button on the Approval Status window.  

The Case Manager follows the same steps to approve the FSS. 
The Case Manager can only approve the FSS after you (and any 
other approvers) have completed the approval process.  

Once the approval is complete, the following Alert To-Do 
displays on the Case Planner’s Staff To-Do List: 

“Approval Complete! Events have been frozen.” 

CONNECTIONS notifies WMS that the FSS stage is closed; 
WMS updates the codes to reflect the stage closure. Although 
the WMS codes are updated, the worker must also close the case in WMS separately. 

Stage Closure Rejection Process 

The supervisor must click on 
the OK button to close the 

message and return to his/her 
Staff To-Do List, where s/he 
can select the Approval Task 
To-Do for the Pending FASP. 

In the review process, you or the Case Manager may find that submitted work needs to be 
rejected if it is incomplete or inaccurate. To reject the stage closure, you must record comments 
explaining what the Case Planner needs to modify; recording comments enables the Reject 
button. CONNECTIONS sends a Task To-Do that displays on the Case Planner’s Staff To-Do 
List with a status of REJT (“Rejected”). The Case Planner can then navigate to the task in order 
to modify and resubmit the stage for closure. The stage closure cannot be approved by other 
approvers when it has been rejected. If an approver navigates from the Approval Task To-Do, a 
message displays, indicating that the approval has been invalidated by another approver and 
that the Approval Task To-Do will be deleted. When the approver clicks on the OK button in 
response to that message, the Approval Status window displays the REJT (“Rejected”) status 
for the approver who rejected the stage closure and INVD (“Invalidated”) for all other 
outstanding approvals. The only way to exit the Approval Status window in this circumstance is 
to click on the Cancel button; the Approval Task To-Do no longer displays on the Staff To-Do 
List. 
Events are generated to the Event List when you reject submitted work. You will be able to view 
the original reason(s) for rejecting the task to make certain the worker has made the requested 
modifications. 
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Step-by-Step: 
Approving a Stage Closure 

1 Click on the TO-DO button on the CONNECTIONS Toolbar.  
The Staff To-Do List displays.  

2 From the Staff To-Do List, select the “Approve FSS Stage Closure” row.  
3 Click on the Navigate… button. 

If the FSS is the only stage in the case, the following message displays: 
“Closing of stage will close the case – do you wish to continue?” 
To proceed with the case and stage closure, click on the Yes button and the 
Case Summary window displays.  

If this FSS was one in which the Stage Closure Question was required and 
answered, the following message displays: 

“The Closure Question has been answered.” 
Click on the OK button to close the message window. 

4 Review the information on the Case Summary window, then click on the Close 
button. 
The Approval Status window displays. 

5 Select the approval item listed with your name in the grid. 
6 Click on the Approve button.  

The following message displays: 
“Approval completion will freeze events and all draft Progress Notes for the stage. 
Do you wish to add another approver?” 

7 Click on the No button to complete the approval without adding another approver. 
The Status field changes to “APRV” (Approved). Skip to Step 12. 
—OR— 
Click on the Yes button to add another approver. 
The To-Do Detail window displays. 

8 Click on the Staff… button. 
The Staff Search Criteria window displays. 

9 On the Staff Search Criteria window, enter the approver’s name in the First and Last 
Name fields. 

10 Click on the Search button. 
The Staff List displays with the results of your search. 

11 Select the approver and click on the OK button. 
The Approval Status window displays, with the selected person listed in the 
Assigned To field. 

12 Click on the Save button. 
The Staff To-Do List displays. 
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Step-by-Step: 
Rejecting a Stage Closure 

1 Click on the TO-DO button on the CONNECTIONS Toolbar.  
The Staff To-Do List displays.  

2 From the Staff To-Do List, select the “Approve FSS Stage Closure” row.  
3 Click on the Navigate… button. 

If the FSS is the only stage in the case, the following message displays: 
“Closing of stage will close the case – do you wish to continue?” 
To proceed with the case and stage closure, click on the Yes button and the 
Case Summary window displays.  

If this FSS was one in which the Stage Closure Question was required and 
answered, the following message displays: 

“The Closure Question has been answered.” 
Click on the OK button to close the message window. 

4 Review the information on the Case Summary window, then click on the Close 
button. 
The Approval Status window displays. 

5 Select the approval item listed with your name in the grid. 
6 Record comments that explain your decision to reject the stage closure in the 

Comments field. 
The Reject button enables.  

7 Click on the Reject button. 
The Status field changes to “REJT” (Rejected). 

8 Click on the Save button. 
The Assigned Workload displays. 
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Progress Notes 
A main component of your supervisory responsibilities includes reviewing worker’s 
documentation. Casework contacts are recorded on the Progress Notes Detail window in 
CONNECTIONS. The ability to access, view and maintain Progress Notes is dependent on a 
number of factors. The worker’s assigned role in the stage and the need to complete certain 
tasks determine the security rights that are assigned. 

In order to create notes, a worker must be: 
• assigned a role in the stage;  
• granted maintain access to the Assigned Workload of a worker who has a role in the 

stage; 
• within the assigned worker’s unit hierarchy (e.g., the Unit Approver);  
• assigned the ENTER PROG NOTE Business Function; or 
• assigned a Progress Notes Task To-Do (created via the Progress Notes window by 

clicking on the Options menu and selecting the To Do 
command). 

 
In order to modify notes, a worker must be:  

• the Progress Note’s Author; or 
• the Progress Note’s Entered By person (e.g., Clerical 

staff). 

Supervisors cannot modify  
entries recorded by  

another worker; however; you 
can add an addendum. 
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Searching for Progress Notes 
A Progress Notes search can be conducted on the Progress Notes window. You may find it 
useful to search for notes (e.g., to view previously recorded notes when reviewing work, to 
determine the number of home visits and casework contacts in a given time period, how up-to-
date your worker’s notes are, etc). For example, if you want to know how many home visits 
have been made in the past six months, choose a date range that corresponds with the last six 
months and select “Foster Home” for the location of the contact. This search will return foster 
home visits from the past six months. 

 

Step-by-Step: 
Searching for Progress Notes 

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 Select the desired FSS stage. 
3 Click on the Tasks… button. 

The Family Services Stage displays. 
4 Click on the Progress Notes tab. 

The Progress Notes window displays. 
5 On the Progress Notes window, enter search criteria in the data fields in the upper 

half of the window. 
Multiple fields can be used to search for notes; however, keep in mind that the more 
search criteria you enter, the more limited your search will be. 

6 Click on the Search button. 
The search results display with all notes that match the search criteria. To complete 
another search, click on the Refresh List button to search the entire record for the 
stage, otherwise search results are based on the existing criteria. 

Recording Progress Notes 
In your supervision of workers, you may want to record details of case conferences and 
discussions you have with your workers related to their cases. You may also need to record a 
note related to a contact you made on a case (e.g., a telephone discussion with your legal staff). 
Progress Notes you record are listed with your name as the Entered By person and the author. 

 

Step-by-Step: 
Recording Progress Notes 

1 See “Accessing a Worker’s Assigned 
Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 Select the desired FSS stage.  

Progress notes cannot be 
recorded when an approval is 

pending for a stage closure. To 
enter a progress note in this 
case, the pending approval 

must be invalidated. 

3 Click on the Tasks… button. 
The Family Services Stage displays. 

4 Click on the Progress Notes tab. 
The Progress Notes window displays. 
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5 On the Progress Notes window, click on the New Note button to open the Progress 
Notes Detail window to create a new note. 
The Author field on the Progress Notes Detail window pre-populates with the name 
of the worker logged on to CONNECTIONS; to change this information, click on the 
drop-down arrow for the Author field and select a different author from the resulting 
list. 

6 In the Event Date field, click on the checkbox for the current date to accept that date. 
To select a different date, click on the drop-down arrow and select from the resulting 
calendar. 

 

7 In the Type field, click on the ellipsis (…) button to 
the right of the field. 
The Type window displays. 

8 Select one or more types by clicking on the 
corresponding checkbox(es). 

9 Click on the OK button. 
The Progress Notes Detail window displays. 

10 Click on the drop-down arrow for the Method of 
Contact field and select from the resulting list, if applicable. 

If you are recording a progress 
note related to case supervision 
you provided to a worker, select 

the Supervisor/Managerial 
Review in the Type field. 

11 Record the time of the contact in the Time field, if 
applicable. 

 12 Click on the drop-down arrow for the Location of 
Contact field and select from the resulting list, if 
applicable. 

The Method of Contact and 
Location of Contact fields are 

not available if a Type of 
“Summary” or 

“Supervisor/Managerial Review” 
is selected. 

13 In the Family Participant/Focus field, select the 
appropriate individual(s) as the Family 
Participant(s) and/or Focus(es) of the contact by 
clicking on their respective checkboxes. 

14 If applicable, select Other Participants or contacts by clicking on the ellipsis (…) 
button to the right of the Other Participant field and clicking on the checkbox(es) to 
select the appropriate participant(s). 

15 In the Purpose field, click on the ellipsis (...) button. 
The Purpose window displays. 

16 Select one or more purposes by clicking on the corresponding checkbox(es). 
17 Click on the OK button. 

The Progress Notes Detail window displays. 
18 Record the narrative of the progress note in the narrative field. 
19 Click on the Save as Draft or Save as Final button. 

See “Recording Progress Notes” on page 35 for information about these options. 
The following message displays: “Changes have been saved.” 

20 Click on the OK button. 
The Progress Notes window displays. 
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Saving Progress Notes  
There are two ways to save a Progress Note: as “Draft” and as “Final.” Each time a note is 
saved, CONNECTIONS keeps an historical record of when notes are saved and by whom. 

Save as Draft Notes can be saved in “Draft” status for up to 15 calendar days from the 
te of the first save. Modifications can be made only during the Draft 
riod by the Author or Entered By person. As part of the nightly batch 
date, CONNECTIONS identifies any notes that have been in “Draft” 

atus for 15 calendar days and changes the status to “Final.” When the
te is saved in “Draft” status, the newly saved note displays in the 
arch results grid on the Progress Notes window and the Note Status
lumn populates with “Draft.” When a stage is closed, CONNECT
nverts any notes in “Draft” status to “Final” status. 
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Save as Final Progress Notes should be saved as 
inal” as soon as possible. To save a 
te as “Final,” click on the Save as 
nal button. The note can be saved as 
inal” at any time during the 15 
lendar-day “Draft” period. Notes in 

inal” at the end of the 15 calend
riod. The Note Status column on the 
ogress Notes window populates with 
inal.” A note saved as “Final” freezes; 
odifications can no longer be made to 

te.  

 
All Progress Notes must be 

saved as “Final” prior to 
prov  iding them to any entity
that o is legally authorized t

receive the record (e.g., 
family court, district attorney). 
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Modifying Progress Notes 
Progress Notes can only be modified while in “Draft” status. In order to modify a note, you must 
be the Entered By person or the Author. If the Type of contact is changed, CONNECTIONS 
clears all of the worker-recorded data, with the exception of the narrative. If the Method of 
Contact is modified, the system clears all data fields that are inconsistent with the newly- 
selected method.  

Warning messages may display if you attempt to modify Progress Notes, as follows: 

Field Modified Message 
Type of Contact  “Changing the TYPE will clear all user entered data fields 

except the Narrative. Continue making changes?” 
• Clicking on the Yes button discards the data. 
• Clicking on the No button retains the data recorded in the fields. 

In both cases, the Progress Notes Detail window remains open. If the 
Type is modified, fields that were cleared by CONNECTIONS need to 
be re-recorded. 

Method of Contact  “Changing the METHOD may clear the user entered data fields that are 
inconsistent with the new METHOD selection.  

Continue making changes?” 

• Clicking on the Yes button clears all recorded data fields (except 
for the Type field, the Method field and the narrative) on the 
Progress Notes Detail window. 

• Clicking on the No button retains the date recorded in the fields.  
In both situations, the Progress Notes Detail window remains open. If 
the Method of Contact is modified, fields that were cleared by 
CONNECTIONS need to be re-recorded. 

 

 

Step-by-Step: 
Modifying a Progress Note 

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 Select the desired FSS stage. 
3 Click on the Tasks… button. 

The Family Services Stage displays. 
4 Click on the Progress Notes tab. 

The Progress Notes window displays.  
5 On the Progress Notes window, click on the note in “Draft” status to be modified.  
6 Click on the Edit Note button. 

The Progress Notes Detail window displays for the selected Progress Note. 
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7 Make the necessary modifications. Once all of the required fields are recorded, click 
on the Save as Draft button. 
—OR— 
Click on the Save as Final button. 
The following message displays: “Changes have been saved.” 

8 Click on the OK button. 
The Progress Notes window displays. 

Adding an Addendum to a Progress Note 
To record additional information for notes in “Final” status, addenda are necessary. You may 
find this functionality useful, since supervisors cannot modify their worker’s notes. In your review 
of a worker’s documentation, you may find that you need to add additional content to a note 
recorded by a worker whom you supervise.  

Addenda can be added by the Progress Note’s Author, by anyone in the Author’s unit hierarchy 
and by the Progress Note’s Entered By person. When the Author of a Progress Note is 
identified as “Other,” a new addendum may be added by the Progress Note’s Entered By 
person, the assigned worker and anyone in the Entered By person’s unit hierarchy (e.g., 
supervisor/Unit Approver). A person outside of the unit hierarchy cannot amend a Progress 
Note when the author is identified as “Other”; a new note must be created. 

 

 

Step-by-Step: 
Adding an Addendum 

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 Select the desired FSS stage. 
3 Click on the Tasks… button. 

The Family Services Stage displays. 
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4 Click on the Progress Notes tab. 
The Progress Notes window displays. 

5 From the Progress Notes window, click on a note that is in “Final” status. 
6 Click on the Options menu and select Add Addendum. 

The Progress Notes Detail window displays for the selected Progress Note. All 
existing fields and the narrative are “locked” and cannot be modified. The narrative 
section of the note is stamped with the time and date, as well as the name of the 
Entered By person. 

7 Record a narrative. 
8 Click on the Save as Final button. 

The following message displays: “Changes have been saved.”  
9 Click on the OK button. 

The Progress Notes window displays. Once an addendum has been added to a 
Progress Note, the Addendum column of the search grid is flagged with a “Y,” 
indicating an addendum exists for the note. For notes that do not have addenda, the 
column is flagged with an “N.” 
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Generating Reports  

The Family Services Intake Report  
This report displays the information that was recorded in CONNECTIONS as part of an FSI. 
This is one way for you to verify that workers are recording the necessary information as part of 
the FSI process (e.g., Requested Services, Emergency Services, Critical Concerns). Rather 
than having to navigate through each tab in the FSI, you can simply print out the report for one 
or more FSI stages. 

 

Step-by-Step: 
Generating a Family Services Intake Report  

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 From the worker’s Assigned Workload, select the desired FSI or FSS stage. 
3 Click on the Reports menu and select the Family Services Intake Report 

command. 
The FSI Intake Report displays in the report viewer. To print the report, click on the 
Print button. 

4 Click on the Close button. 
The Assigned Workload displays. 

The Family Services Intake Log 
The FSI Log enables staff to locate Family Services Intakes. The system returns results that 
match the search criteria entered. This log lists Intake activity within a specified time period. As 
a means to monitor worker activity/productivity, you can perform a search of Family Services 
Intakes that were generated within your agency. You can see if your workers have generated 
FSIs, for whom FSIs were generated and when they were created.  

 

Step-by-Step: 
Generating an FSI Log Report 

1 On the CONNECTIONS Toolbar, click on the Intake menu and select the Family 
Services Intake Log command. 
The Family Services Intake Log window displays. 

2 Enter required search criteria, including Date From and Date To. Enter any other 
search parameters, if desired, and click on the Search button. 
You must limit the date range to one month or less. The search results display in the 
lower half of the window.  

3 Click on the Reports menu and select the FSI Log Report command. 
The report displays in the report viewer.  

4 To print the report, click on the Print ( ) button. 
5 Click on the Close button to close the report. 

The Family Services Intake Log window displays. 
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The Family Services Face Sheet 
The Family Services Face Sheet provides a quick overview of case, worker and Stage 
Composition information. This is another way for you to verify that workers are recording the 
required information and maintaining demographics for all people in the stage. 

 

Step-by-Step: 
Generating a Family Services Face Sheet from the Assigned Workload 

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 From the worker’s Assigned Workload, select the FSI or FSS stage.  
3 Click on the Reports menu and select the Family Services Face Sheet command. 

The following message displays: 
“The report has been launched. Check Report List Window.” 

4 Click on the Close button. 
The Assigned Workload displays. 

5 Click on the RPRTS (Reports) button.  
The Report List displays. 

6 Select the Family Services Face Sheet report. 
Make sure the value in the Status column is “DONE.” If the status is “PEND” or 
“RUN” click on the Refresh button. 

7 Click on the Open button. 
The Family Services Face Sheet displays in Microsoft Word. 

8 To print the Family Services Face Sheet, click on the Print ( ) button. 
—OR— 
Click on the File menu and select the Print command. 

9 Click on the File menu and select the Close command. 
The Report List displays. 

10 Click on the Close button. 
The Assigned Workload displays. 
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Open Caseload Inquiry (OCI) Report 
There are two types of reports available that enable you to check the status of work and 
assignments for which your staff are responsible: the Open Caseload Inquiry report (for CPS 
stages) and the Family Services Open Caseload Inquiry report (for FSI and FSS stages). 

If you supervise workers who are responsible for CPS Investigations, the Open Caseload 
Inquiry (OCI) Report lists and identifies the status of all Safety Assessments and Investigation 
Conclusions that a caseworker needs to complete. The list is organized by case and includes all 
open cases that have been progressed to the Investigation stage for which the caseworker is 
the Primary worker. It provides a snapshot of information about a caseworker’s Assigned 
Workload, including the total number of open Investigations, cases and overdue 7-day Safety 
Assessments and Investigation Conclusions. With this report, you can monitor a worker’s 
productivity and timeliness of adhering to regulations or requirements for completing 
documentation. This can also serve as a reminder to you of what work you need to approve. 

 

Step-by-Step: 
Generating the OCI Report 

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 Click on the Reports menu and select the OCI by Worker command. 
The following message displays: 
“The Report has been launched. Check Report List Window.” 

3 Click on the OK button. 
4 Click on the RPRTS button on the CONNECTIONS Toolbar.  

The Report List displays. 
5 Select the OCI Report you just generated. 

Make sure the value in the Status column is “DONE.” If the status is “PEND,” click 
on the Refresh button. 

6 Click on the Open button. 
The report opens as a Microsoft Word document. 

7 To print the OCI report, click on the Print ( ) button. 
—OR— 
Click on the File menu and select the Print command. 

8 Click on the File menu and select the Close command. 
The Report List displays. 

9 Click on the Close button. 
The Assigned Workload displays. 
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The Family Services Open Caseload Inquiry (OCI) Report  
Just as the OCI report described in the previous section provides a list of assignment statuses 
for workers assigned to CPS stages, supervisors of Family Services workers can access a 
report that enables them to track their workers’ assignments. This “real-time” report lists stages 
assigned to individual workers to include coming-due and overdue FASPs. The report provides 
you with a quick view of the Family Services Intakes and Family Services Stages assigned to a 
worker (no information is included regarding CPS stages). 

 

Step-by-Step: 
Generating the Family Services OCI Report 

1 See “Accessing a Worker’s Assigned Workload” on page 8 to access your worker’s 
Assigned Workload. 

2 Click on the Reports menu and select the Family Services OCI by Worker 
command. 
The following message displays: 
“The Report has been launched. Check Report List Window.” 

3 Click on the OK button. 
4 Click on the RPRTS button on the CONNECTIONS Toolbar.  

The Report List displays. 
5 Select the OCI Report you just generated. 

Make sure the value in the Status column is “DONE.” If the status is “PEND,” click 
on the Refresh button. 

6 Click on the Open button. 
The report opens as a Microsoft Word document. 

7 To print the Family Services OCI report, click on the Print ( ) button. 
—OR— 
Click on the File menu and select the Print command. 

8 Click on the File menu and select the Close command to close the report. 
The Report List displays. 

9 Click on the Close button. 
The Assigned Workload displays. 
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Data Warehouse Reports 
The OCFS Data Warehouse is a repository of data from CONNECTIONS and CCRS, enabling 
workers to generate reports based on information recorded in those systems. Reports can be 
produced at an aggregate level to identify trends or at a more detailed level for operational 
purposes. Data regarding CPS allegations and investigations, foster care facilities, admissions 
to foster care, discharges from foster care, and children in foster care can be viewed for a 
current point-in-time snapshot or historically. 

OCFS is developing a set of Data Warehouse Build 18 Reports to provide managers and 
supervisors with a single, comprehensive set of reports to help meet the basic operational 
reporting needs of supervisory and managerial staff. The reports, which are generated from the 
OCFS Data Warehouse, can be easily accessed from any CONNECTIONS computer. The Data 
Warehouse Build 18 reports focus on the management and operation of case management 
resources and services, as well as the execution of related roles and responsibilities in 
delivering services to children and families. 

For more information on the OCFS Data Warehouse or to request a Data Warehouse password, 
e-mail the Data Warehouse Team at data.warehouse@nysemail.state.ny.us. A Job Aid 
specifically for Build 18 Data Warehouse reports will also be posted to the OCFS 
CONNECTIONS intranet site. 
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